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Important Information

Warranty

The serial hardware is warranted against defects in materials and workmanship for a period of one year from the date of shipment,
as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves
to be defective during the warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions,
due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other
documentation. National Instruments will, at its option, repair or replace software media that do not execute programming
instructions if National Instruments receives notice of such defects during the warranty period. National Instruments does not
warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of
the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of
returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed

for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to

make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should consult
National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages arising out of

or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR
NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL
INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR
CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of National Instruments will
apply regardless of the form of action, whether in contract or tort, including negligence. Any action against National Instruments
must be brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in
performance due to causes beyond its reasonable control. The warranty provided herein does not cover damages, defects,
malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or
surges, fire, flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including

photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written
consent of National Instruments Corporation.

Trademarks

CVI™, LabVIEW"™, National Instruments™, and ni.com™ are trademarks of National Instruments Corporation.

Product and company names mentioned herein are trademarks or trade names of their respective companies.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS

(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL
OF RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL
COMPONENTS IN ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE
EXPECTED TO CAUSE SIGNIFICANT INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS
CAN BE IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL
POWER SUPPLY, COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE
FITNESS, FITNESS OF COMPILERS AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION,
INSTALLATION ERRORS, SOFTWARE AND HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR
FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES, TRANSIENT FAILURES OF ELECTRONIC
SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR MISUSES, OR ERRORS ON THE PART OF
THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE HEREAFTER
COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH)
SHOULD NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM
FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE
REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO
BACK-UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS
FROM NATIONAL INSTRUMENTS' TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER
MAY USE NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT
EVALUATED OR CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS
ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL
INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE INCORPORATED IN A
SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND
SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



Compliance

FCC/Canada Radio Frequency Interference Compliance*

Determining FCC Class

The Federal Communications Commission (FCC) has rules to protect wireless communications from interference.
The FCC places digital electronics into two classes. These classes are known as Class A (for use in industrial-
commercial locations only) or Class B (for use in residential or commercial locations). Depending on where it is
operated, this product could be subject to restrictions in the FCC rules. (In Canada, the Department of
Communications (DOC), of Industry Canada, regulates wireless interference in much the same way.)

Digital electronics emit weak signals during normal operation that can affect radio, television, or other wireless
products. By examining the product you purchased, you can determine the FCC Class and therefore which of the two
FCC/DOC Warnings apply in the following sections. (Some products may not be labeled at all for FCC; if so, the
reader should then assume these are Class A devices.)

FCC Class A products only display a simple warning statement of one paragraph in length regarding interference and
undesired operation. Most of our products are FCC Class A. The FCC rules have restrictions regarding the locations
where FCC Class A products can be operated.

FCC Class B products display either a FCC ID code, starting with the letters EXN, Trade Name Mol Namber

or the FCC Class B compliance mark that appears as shown here on the right. F@ Testad 1o Comply

Consult the FCC web site http: //www. fcc.gov for more information. with FOC Standards
FOR HOME OR OFFICE USE

FCC/DOC Warnings

This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance with the
instructions in this manual and the CE Mark Declaration of Conformity**, may cause interference to radio and
television reception. Classification requirements are the same for the Federal Communications Commission (FCC)
and the Canadian Department of Communications (DOC).

Changes or modifications not expressly approved by National Instruments could void the user’s authority to operate
the equipment under the FCC Rules.

Class A

Federal Communications Commission

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the
equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to
radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in
which case the user will be required to correct the interference at his own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Reéglement sur le matériel brouilleur du
Canada.

Class B

Federal Communications Commission

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following measures:

» Reorient or relocate the receiving antenna.
» Increase the separation between the equipment and receiver.



* Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
¢ Consult the dealer or an experienced radio/TV technician for help.

Canadian Department of Communications
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Reglement sur le matériel brouilleur du
Canada.

European Union - Compliance to EEC Directives

Readers in the EU/EEC/EEA must refer to the Manufacturer's Declaration of Conformity (DoC) for information**
pertaining to the CE Mark compliance scheme. The Manufacturer includes a DoC for most every hardware product
except for those bought for OEMs, if also available from an original manufacturer that also markets in the EU, or
where compliance is not required as for electrically benign apparatus or cables.

*  Certain exemptions may apply in the USA, see FCC Rules §15.103 Exempted devices, and §15.105(c).
Also available in sections of CFR 47.

** The CE Mark Declaration of Conformity will contain important supplementary information and instructions
for the user or installer.
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About This Manual

This manual contains instructions to help you install and configure the
National Instruments serial hardware and the NI-Serial software for
Windows NT. The serial hardware covered by this manual includes the
PCMCIA-232, PCMCIA-232/2, PCMCIA-232/4, PCMCIA-485, and
PCMCIA-485/2. This manual assumes that you are already familiar with
Windows NT.

Conventions

This manual uses the following conventions:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

@ This icon denotes a note, which alerts you to important information.

bold Bold text denotes items that you must select or click on in the software,
such as menu items and dialog box options. Bold text also denotes
parameter names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames and extensions, and code excerpts.

monospace bold Bold text in this font denotes the messages and responses that the computer
automatically prints to the screen. This font also emphasizes lines of code
that are different from the other examples.

© MNational Instruments Corporation Xi PCMCIA Serial for Windows NT



About This Manual

Related Documentation

PCMCIA Serial for Windows NT

The following documents contain information that you might find helpful
as you read this manual:

ANSI/EIA-232-D Standard, Interface Between Data Terminal
Equipment and Data Circuit-Terminating Equipment Employing
Serial Binary Data Interchange

EIA/RS-422-A Standard, Electrical Characteristics of Balanced
Voltage Digital Interface Circuits

EIA-485 Standard, Standard for Electrical Characteristics of
Generators and Receivers for Use in Balanced Digital Multipoint
Systems

Microsoft Win32 Software Developer Kit, Online Documentation for
Win32 Overviews, Win32 Reference, and Microsoft Windows NT
System Guide, Microsoft Corporation

NS16550A4F Universal Asynchronous Receiver/Transmitter with
FIFOs, National Semiconductor

ST16C654 Asynchronous Receiver/Transmitter with FIFOs,
EXAR Corp.

Xii ni.com



Introduction

This chapter explains how to use this manual, lists what you need to get
started, provides an overview of the serial hardware and the NI-Serial
software, and describes optional equipment you can order.

How to Use This Manual

to Get Started

v

( | Install the NI Serial Software

v

| Install the Serial Hardware I
[

Chapter 1 ( Gather What You Need )

v

| Verify the Installation I

Chapter 2<
No .
———»| Troubleshooting
Yes
\ | Connect the Cables I
Chapter 3 | Configure the Serial Port I

Learn About Transceiver
Control Modes

Chapter 4 +

Review Programming
Requirements

v

C Write Application Program )
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Chapter 1 Introduction

What You Need to Get Started

Make sure you have all of the following items before you attempt to install
the serial hardware and software:

U Windows NT version 4.0 or later installed on your computer

U One of the following serial interfaces, which is included in your kit:

PCMCIA-232 (one, two, or four port)
PCMCIA-485 (one or two port)

U CD, NI-Serial Software for Windows 2000/NT/Me/9x, which is
included in your kit

(| Adapter cable from PCMCIA card to DB-9 connector, which is
included in your kit

Optional Equipment

Call National Instruments for more information about the following
optional equipment:

e DB-9 RS-485 termination connector
e RS-232 9-pin to 9-pin null modem cable
e RS-232 9-pin to 25-pin null modem cable

Serial Hardware OQverview

PCMCIA Serial for Windows NT

The serial hardware gives you a variety of solutions for serial
communications. The PCMCIA-232 interfaces work with the RS-232
protocols, and the PCMCIA-485 interfaces work with the RS-422 and
RS-485 protocols. You can use the PCMCIA-232 hardware for serial
communication up to distances of 50 ft. You can connect the PCMCIA-485
hardware with up to 31 devices using serial cable lengths up to 4,000 ft.

The PCMCIA-232 is available with one, two, or four ports. The
PCMCTA-48S5 is available in a one-port version or two-port version. All
PCMCIA cards come with cables for each port that terminates in a standard
DB-9 D-Sub connector. Throughout this manual, references to PCMCIA
serial interfaces generally refer to all versions of the interfaces.

The PCMCIA-485 interfaces support four hardware transceiver control
modes for reliable communication with two-wire and four-wire devices.

1-2 ni.com



Chapter 1 Introduction

Refer to Chapter 4, Using Your Serial Hardware, for more information
about transceiver control modes.

All of the serial hardware uses standard 16550-compatible UARTSs
(Universal Asynchronous Receiver/Transmitters) for 100 percent
compatibility with standard PC COM ports. The serial hardware contains
FIFOs (First-In-First-Out buffers) for reduced susceptibility to interrupt
latency and faster transmission rates. Full Plug and Play compatibility gives
you the convenience of switchless configuration and installation. Refer to
Appendix D, Specifications, for more information about the serial
hardware specifications and operating conditions.

Ni-Serial Software Overview

The NI-Serial software for Windows NT includes a native Windows NT
kernel driver that can provide full interrupt-driven, buffered I/O for
multiple COM ports. You can obtain a maximum baud rate of 115.2
KBaud. The NI-Serial software also provides a configuration utility, which
is integrated with the Windows NT Control Panel. Refer to Appendix D,
Specifications, for more information about software specifications and
recommended operating conditions.

The NI-Serial software includes the following components:
*  Device driver
*  Diagnostic test

*  Configuration utility

e Product manuals

The NI-Serial software supports all National Instruments serial hardware,
including all AT, PCI, PXI, CompactPCI, and PCMCIA versions.

Time-Saving Development Tools

Your kit includes the NI-Serial software for Windows NT. In addition, you
can order the LabWindows/CVI or LabVIEW software from National
Instruments to speed your application development time and make it easier
to communicate with your instruments.

LabVIEW is an easy-to-use, graphical programming environment

you can use to acquire data from thousands of different instruments,
including IEEE 488.2 devices, VXI devices, serial devices, PLCs, and
plug-in data acquisition boards. After you have acquired raw data, you can

© National Instruments Corporation 1-3 PCMCIA Serial for Windows NT



Chapter 1 Introduction

convert it into meaningful results using the powerful data analysis routines
in LabVIEW. LabVIEW also comes with hundreds of instrument drivers,

which dramatically reduce software development time, because you do not
have to spend time programming the low-level control of each instrument.

LabWindows/CVI is similar to LabVIEW, except that it combines an
interactive, easy-to-use development approach with the programming
power and flexibility of compiled ANSI C code.

For ordering information, or to request free demonstration software,
contact National Instruments.

Using Your Serial Hardware with LabVIEW and
LabWindows/CVI

PCMCIA Serial for Windows NT

After you install your serial hardware and the NI-Serial software, you can
use standard serial I/O functions in LabVIEW and LabWindows/CVI with
your serial interface. If you already have LabVIEW or LabWindows/CVI
and want to use it with your serial hardware, refer to your LabVIEW or
LabWindows/CVI documentation for information about serial I/O
functions.

1-4 ni.com



Installation and Verification

This chapter contains instructions to help you install the NI-Serial software,
serial hardware, and cables, and to verify the installation.

Install the NI-Serial Software

Install the NI-Serial software for Windows NT before you install the
hardware.

1. Logon as Administrator or as a user who has Administrator
privileges.

2. Select Start»Settings»Control Panel.

Double-click on the Add/Remove Programs icon in the Control Panel
to launch the Add/Remove Programs applet. A dialog box similar to
the one in Figure 2-1 appears.

© National Instruments Corporation 2-1 PCMCIA Serial for Windows NT



Chapter 2 Installation and Verification

Add/Remove Frograms Properties EHE I

Install/Uninstall | windows NT Setup |

Toinstall a news program from a floppy disk or CO-BOM
drive, click nstall.

The following software can be autoratically removed by
Windows, Toremove a program or ko modify itz installed
components, select it from the list and click
Add/Remove,

Adobe Acrobat Reader 2.0

Data Access Objects [DAO] 3.0

Internet Explarer 3.0

Microzoft Developer Metwark Library - Visual Studio 57
Microsoft Wisual C++

Mukdega SoftlCE

SddyEEmovE.. |

QK | Cancel | Appli |

Figure 2-1. Add/Remove Programs Properties Dialog Box

4. Click on the Install button.

When prompted, insert the NI-Serial Software for Windows
2000/NT/Me/9x CD and click on the Next button to proceed. The
software installation wizard begins with the screen shown in
Figure 2-2.

PCMCIA Serial for Windows NT 2-2 ni.com



Chapter 2 Installation and Verification

NI Serial Software

‘Welcome to the NI Serial Software Setup program.  This program
will inztall NI Serial Software on vour cormputer.

It iz strongly recommended that wou exit all \Windows programs
before running thiz Setup progran,

Click Cancel to quit Setup and then close any programs pou have
running. Click Mest to continue with the Setup program.

WARNING: This program iz protected by copuright law and
interational treaties.

Unautharized reproduction or distribution of this prograrm, or any
partion of it, may result in severe civil and criminal penalties, and
will be: prozsecuted to the maximun extent possible under law.

Canhicel |

Figure 2-2. NI-Serial Setup Screen

The setup wizard guides you through the necessary steps to install the
NI-Serial software. You can go back and change values where
appropriate by clicking on the Back button. You can exit the setup
where appropriate by clicking on the Cancel button.

@ Note This installation backs up the Microsoft Windows NT serial driver serial.sys to
serial.bak and then overwrites serial.sys. You can find serial.sys in the
Windows NT. . . \system32\drivers directory.

The software installation is complete. Proceed to the next section, Install
the PCMCIA Serial Hardware.

Install the PCMCIA Serial Hardware

Complete the following steps to install the PCMCIA-232 or PCMCIA-485
in your computer:

1.
2.

© MNational Instruments Corporation

Shut down the computer.

Insert the card into a free PC Card (PCMCIA) socket the same way you
insert a disk into a floppy drive. The card has no jumpers or switches
to set.

Power on the computer and start Windows NT.
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Chapter 2 Installation and Verification

Figure 2-3 shows how to insert a PCMCIA serial card and how to connect
the cable.

Portable

/ Computer

|

PCMCIA
Socket

PCMCIA

. Serial Cable

Figure 2-3. Inserting a PCMCIA Serial Card

Proceed to the next section, Select Resources for the PCMCIA Card.

Select Resources for the PCMCIA Card

Complete the following steps to select resources for your PCMCIA card.

1.
2.
3.

5.

Select Start»Settings»Control Panel.
Double-click on the niports icon.

Select the PCMCIA card you just installed from the Add a New
PCMCIA Card list, and click on the Add button.

In the Resource Configuration dialog box, select nonconflicting base
I/0O address and IRQ settings for your port/card, and click on OK.

For more information on selecting resources for your port/card, refer
to the Resource Settings section in Chapter 3, Configuration.

Exit niports and restart the computer.

After you have selected resources for your PCMCIA card, proceed to the
next section, Verify the Installation.

PCMCIA Serial for Windows NT
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Verify the Installation

Determine Which Physical Port Is Associated with COMx

Select Start»Settings»Control Panel, and double-click on niports. A list
showing installed National Instruments ports with their logical COMx
names appears. If your interface is not on the list, refer to Appendix C,
Troubleshooting and Common Questions.

Select the COM port you want and click on the Settings button to display
the General Port Settings dialog box for that port. This dialog box
displays the physical port number starting at 1.

When you have finished verifying the driver installation and physical port,
proceed to the next section, Run the Diagnostic Test.

Run the Diagnostic Test

To verify and test the installation, run the diagnostic program that came
with your NI-Serial software. The diagnostic program verifies that your
serial driver is installed properly, that the configuration of your hardware
does not conflict with anything else in your system, and that the serial
driver can communicate with your hardware correctly.

To run the test, select the diagnostics item under Start»Programs»
National Instruments Serial.

If the diagnostic test completes with no failures, your serial hardware and
software are installed properly. If it fails, refer to Appendix C,
Troubleshooting and Common Questions, for troubleshooting instructions.
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Connect the Cabhles

PCMCIA Serial for Windows NT

For the PCMCIA serial cards, you can use the standard DB-9 connector

found on most serial cables.

Figure 2-4 and Table 2-1 give the pin locations and descriptions of the
DB-9 connector, which is found on the PCMCIA serial cable.

PIN 5

PIN 1

PIN 9

PIN 6

Figure 2-4. DB-9 Connector Pin Locations

Table 2-1. DB-9 Pin Descriptions

DB-9 Pin 232 Signal 485 Signal
Pin 1 DCD GND
Pin 2 RXD CTS+ (HSI+)
Pin 3 TXD RTS+ (HSO+)
Pin 4 DTR RXD+
Pin 5 GND RXD-
Pin 6 DSR CTS- (HSI-)
Pin 7 RTS RTS- (HSO-)
Pin 8 CTS TXD+
Pin 9 RI* TXD-

* This signal is not supported on ports 3 and 4 of the four-port version.

2-6
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Connecting Two-Wire Devices

The PCMCIA-485 cards are designed to work with either two- or four-wire
devices. If you are using a two-wire device, refer to the device
documentation for specific wiring instructions.

In general, half-duplex networks use a single twisted pair of wires for
communication in both directions, so you must connect both the transmitter
and the receiver at each end of the same pair of wires. For example, to
connect an RS-485 data acquisition device to a port on your PCMCIA-485
using half-duplex communication, you need a single twisted pair of wires.
At the PCMCIA-485, connect the TXD+ and RXD+ signals (pins 8 and 4
on a DB-9 connector) together and to one wire. Connect the other end of
this wire to both the TXD+ and RXD+ signals on the data acquisition
device. You use the same method to connect the TXD- and RXD- signals
(pins 9 and 5 on a DB-9 connector) to the second wire.

Refer to Chapter 4, Using Your Serial Hardware, for information on setting
the transceiver mode for two-wire communication. Refer to Appendix A,
Serial Port Information, for more information on duplex architectures.
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Configuration

This chapter contains instructions to help you view or change the
communication port settings.

Change/View Communication Port Settings

The serial configuration utility is fully integrated with the Windows NT
Control Panel. You can use it to examine or modify the configuration of the
serial port.

Follow these steps to configure the serial port.

1. Select Start»Settings»Control Panel and double-click on the niports
icon. A list of National Instruments ports appears, as shown in

Figure 3-1.
Mational Instruments - Ports
Parts:
COME M1 PCMCIA-232/2 &
COM?: NI, POMOIA-232/2 4IE'°$E
Settings... |
= Delete. .. |
Add & Mew PCMCIA card
PCMCIA-485 x| Add.

Figure 3-1. niports Configuration Utility

2. Select the port you are interested in.

3. Click on the Settings button to view or configure the port settings.
Refer to the next section, General Port Settings, for more information.
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4. Click on the Resources button in the General Port Settings dialog
box to view or configure the resources for the port. Refer to the
Resource Settings section, later in this chapter, for more information.

5. Click on Delete to remove hardware information about the port from
Windows NT. You should do this before you physically remove your
PCMCIA card.

6. Click on Add to configure resources for a new PCMCIA card.

General Port Settings

This section describes the options you can set in the General Port Settings
dialog box, shown in Figure 3-2.

General Port 5ettings E

M.I. PCMCIA-232/2

| e B E mitiEr: FORT : 1
LCOM Port Nurnber: Im "I
Transcerer fiode;: I j
[+ EIF0 Enabled
1
Receive FIFD size: . , ,) .
Leww (1] High [14]
1
Tranzmit FIFD size: : : .) |
Low [1] High [16]

Cancel Besources | 0k I

Figure 3-2. General Port Settings Dialog Box
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COM Port Number

You can use the COM Port Number control to change the COMx name of
the port selected.

Transceiver Mode

The transceiver mode selection shows the transceiver mode in use, and
applies only to PCMCIA-485 cards. Refer to Chapter 4, Using Your Serial
Hardware, for more information about transceiver modes. If you use
two-wire TXRDY mode, FIFOs must be enabled.

FIFO Enabled

You can use the FIFO Enabled control to enable or disable the FIFO
buffers on the serial port. FIFO buffers are present on the
16550-compatible UARTs—one for the transmitter and one for the
receiver.

FIFO Buffers

The FIFO buffer control is available by clicking on the Advanced button
on the Port Settings tab. FIFO buffers are present on the 16550-compatible
UARTs—one for the transmitter and one for the receiver. The receive FIFO
trigger denotes the number of characters received in the FIFO before the PC
is interrupted to read the data. The transmit FIFO trigger denotes the
maximum number of bytes written to the FIFO in a block when the PC is
interrupted to write the data. Consider the following points when selecting
FIFO settings:

*  You can select larger FIFO settings to reduce the number of interrupts
and therefore minimize system overhead.

» Iftransfer rates are high, you can lower receive FIFO settings to reduce
the number of interrupts and therefore prevent overrun errors due to
interrupt latency.

» If data transfer sizes are small, selecting receive FIFO settings just
above data sizes can reduce efficiency, so select lower settings.

Resources

Click on the Resources button to display the resource configuration dialog
box for the port. For more information on resource configuration, refer to
the next section, Resource Settings.
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Resource Settings

The following sections explain the resource configuration options for each
serial interface.

PCMCIA-232, PCMCIA-485, PCMCIA-232/4

Figure 3-3 shows the resource configuration dialog box for a
PCMCIA-485. The PCMCIA-232 and PCMCIA-232/4 dialog boxes
are similar.

PCMCIA Port - Resource Configuration 1]

ﬁ M.I. PCHCIA-485

Baze |/0 Address: 100 i

Length of [/0 Window: 8 Bytes

IR: |3 :I'

Cancel |

Figure 3-3. Resource Configuration Dialog Box for the PCMCIA-485

Base I/0 Address: The base I/0 address assigned to the port.
IRQ: The IRQ assigned to the port.
Length: The size (in bytes) of the I/O window.

For the PCMCIA-232 and PCMCIA-485,
the length is 8 (the size of the I/O window
for one port).

For the PCMCIA-232/4, the length is
32 bytes (the size of the I/O window for
four ports).
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PCMCIA-232/2, PCMCIA-485/2

These cards require two base I/O settings, one for each port, and they share
an IRQ.

Figure 3-4 shows the resource configuration dialog box for a
PCMCIA-485/2. The PCMCIA-232/2 dialog box is similar.

PCMCIA Port - Resource Configuration

ﬁ M.I. PCHCIA-435/2

Baze /0 Address: I 2el, 28 hd I

Length of [/0 Window: 8 Buytes

IRG: |3 :I'

Figure 3-4. Resource Configuration Dialog Box for the PCMCIA-485/2

Base I/0 Address: The base I/O addresses assigned to the
two ports.

IRQ: The IRQ shared by the two ports.

Length: The size of each I/O window (in bytes).

@ Note When you select resources for the PCMCIA cards, use the Microsoft Windows NT
diagnostics utility to make sure that the resources have not been assigned to any other
device. This utility displays a list of I/O port addresses and IRQ levels that are currently

being used in your system.
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This chapter describes how to set the hardware transceiver control mode for
your RS-485 interfaces and lists some general programming requirements.

Advanced Transceiver Control for the PCMCIA-485

The PCMCIA-485 cards support four modes of hardware transceiver
control. (Transceiver modes apply only to these interfaces.) You can use
hardware flow control to enable and disable your transmitters and receivers
to work on different bus topologies. Table 4-1 lists the status of the
transmitters and receivers under each of the transceiver control modes.

Table 4-1. Transceiver Control Modes

Mode

Transmitter

Receiver

Four-wire mode

Always enabled

Always enabled

Two-wire mode: Enabled with Always enabled
DTR with echo DTR unasserted

Two-wire mode: Enabled with Enabled with

DTR controlled DTR unasserted DTR asserted
Two-wire mode: Enabled with Enabled with
TXRDY auto control TXRDY asserted TXRDY unasserted

Note Signal names with an overscore, such as DTR, indicate that the signal is active low.

Four-Wire Mode

Use the four-wire mode for most full-duplex systems. In this mode, the
transmitter and receiver are always enabled. This mode is the default.
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Two-Wire Mode: DTR with Echo

Use this mode in half-duplex systems where the DTR (Data Terminal
Ready) line must control the transmitter. In the DTR-with-echo mode, the
transmitter is tri-stated when the DTR signal of the UART (Universal
Asynchronous Receiver/Transmitter) is asserted. To transmit, your
application must first clear the DTR bit to enable the transmitter. After the
data is fully transmitted, your application once again sets the DTR bit to
disable the transmitter. Because the receiver is always enabled in this
mode, you not only receive packets from other devices, you also receive the
packets sent from your transmitter.

Two-Wire Mode: DTR Controlled

This mode is similar to the two-wire, DTR-with-echo mode. Use this mode
in half-duplex systems where the DTR line must control the transmitter.
Although this mode uses the same method as the DTR-with-echo mode to
control the transmitter, the hardware automatically disables the receiver
whenever the transmitter is enabled. Thus, you do not receive packets that
you have transmitted.

Two-Wire Mode: TXRDY Auto Control

In this mode, the hardware transparently enables the transmitter and
receiver in a two-wire system. This mode removes the burden of flow
control from the user software. By connecting the transmitter to the
TXRDY (Transmit Ready) line, the hardware enables the transmitter for
each byte to be transmitted. Also, the hardware disables the receiver
whenever the transmitter is enabled, so you do not receive packets that you
have transmitted.

@ Note It is recommended that you use the two-wire TXRDY auto control mode when
you are communicating with a two-wire device. Because this mode handles the
transmitter/receiver enabling for a two-wire connection in your hardware, it reduces the
software overhead required to perform this operation in your application program. For
more information about serial communication in two- or four-wire modes, refer to the
section Serial Communication Issues in Appendix A, Serial Port Information.

Setting the Transceiver Control Mode

PCMCIA Serial for Windows NT

The recommended method for setting the transceiver control mode is with
the serial configuration utility located in the Windows NT Control Panel.
For more information, refer to the General Port Settings section in
Chapter 3, Configuration. The mode you select in the Control Panel is
automatically configured when you open a port on a serial interface.
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Setting the Transceiver Mode with DeviceloControl

The NI-Serial software extends the Windows function DeviceIoControl
for programming the transceiver control mode. To program the transceiver
control mode using DeviceIoControl, complete the following steps.

1. Add the following lines to your source code.
#include <winioctl.hs>
#define IOCTL_SERIAL SET TRANSCEIVER MODE
CTL_CODE (FILE DEVICE SERIAL PORT, 37,
METHOD BUFFERED, FILE ANY ACCESS)

2. Use the Win32 function DeviceIoControl. Use the defined control
code value listed in Step 1 to set the transceiver mode, and the input
buffer values (unsigned long) listed in Table 4-2 for programming
different transceiver modes.

Table 4-2. DeviceloControl Function Input Values
DeviceloControl
Transceiver Mode Function Input Value
Four-wire mode 128
Two-wire mode: DTR with echo 129
Two-wire mode: DTR controlled 130
Two-wire mode: TXRDY auto control 131

© MNational Instruments Corporation

For example, to set two-wire TXRDY auto control mode, use the
following call:

ULONG TranceiverMode = 131;

DeviceIoControl (hDevice,
IOCTL_SERIAL SET TRANSCEIVER MODE, (PVOID)
&TransceiverMode, sizeof (ULONG) , lpOutBuffer,
nOutBufferSize, lpBytesReturned, 1lpOverlapped) ;
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General Programming Requirements

PCMCIA Serial for Windows NT

Once installed, the NI-Serial software is integrated into the standard
Windows NT communications software. NI serial ports are used like any
other Windows NT communications (COM) port. Windows NT has
standard communication functions for use within either 16-bit (Win16)
applications or 32-bit (Win32) applications.

As you begin developing your application, remember that you must use the
standard Microsoft Windows serial communication functions. For
information about Microsoft Windows serial communication functions,
refer to the Win32 Sofiware Development Kit, online help for Win32
Overviews, and Win32 Reference.

If you have LabVIEW or LabWindows and want to use it with your serial
hardware, refer to your LabVIEW or LabWindows documentation for
information about serial I/O functions.
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Serial Port Information

RS-232

This appendix discusses the RS-232, RS-422, and RS-485 standards
and explains some of the issues involved with these types of serial

communication.

Table A-1 lists the features of the RS-232, RS-422, and RS-485 standards.

Table A-1. RS-232, RS-422, and RS-485 Features

Feature RS-232 RS-422 RS-485
Type of Single ended | Differential Differential
transmission lines
Maximum number | 1 1 32
of drivers
Maximum number | 1 10 32
of receivers
Maximum cable 50 ft. 4,000 ft. 4,000 ft.
length
Maximum data rate | 20 kbytes/s 10 Mbytes/s 10 Mbytes/s
Maximum CMV +25V +7V +12to-7V
Driver output 5to25V 2to6V 1.5to6V
Driver load >3 kQ 100 Q 60 Q

© National Instruments Corporation A-1

RS-232, as specified in the ANSI/EIA-232-D Standard, Interface Between

Data Terminal Equipment and Data Circuit-Terminating Equipment
Employing Serial Binary Data Interchange, standardizes serial

communication between computers and between computer terminals and
modems. Most applications use the RS-232 standard for interfacing
peripherals to personal computers. RS-232 uses transmission lines in which
the state of each signal is represented by referencing the voltage level of a
single line to ground. RS-232 was designed for serial communication up to
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RS-422

distances of 50 ft. and with data rates up to 20 kbytes/s. However, because
of improvements in line drivers and cabling, you can often increase the
actual performance of the bus past the limitations on speed and distance
recommended in the specification.

RS-485

RS-422, as specified in the EIA RS-422-A Standard, Electrical
Characteristics of Balanced Voltage Digital Interface Circuits, defines

a serial interface much like RS-232. However, RS-422 uses balanced

(or differential) transmission lines. Balanced transmission lines use two
transmission lines for each signal. The state of each signal is represented,
not by a voltage level on one line referenced to ground as in RS-232, but
rather by the relative voltage of the two lines to each other. For example,
the TX signal is carried on two wires, wire A and wire B. A logical 1 is
represented by the voltage on line A being greater than the voltage on
line B. A logical O is represented by the voltage on line A being less than
the voltage on line B. Differential voltage transmission creates a signal that
is much more immune to noise as well as voltage loss due to transmission
line effects. Thus, you can use RS-422 for much longer distances

(up to 4,000 ft.) and much greater transmission speeds (up to 10 Mbytes/s)
than RS-232.

PCMCIA Serial for Windows NT

RS-485, as specified in the EIA-485 Standard, Standard for Electrical
Characteristics of Generators and Receivers for Use in Balanced Digital
Multipoint Systems, expands on the RS-422 standard by increasing the
number of devices you can use from 10 to 32 and by working with
half-duplex bus architectures. Unlike the RS-422 standard, RS-485
addresses the issue of using multiple transmitters on the same line. RS-485
defines the electrical characteristics necessary to ensure adequate signal
voltages under maximum load, short-circuit protection, and the ability to
withstand multiple drivers driving conflicting signals at the same time.
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Serial Communication Issues

This section explains some serial communication issues, such as duplex
architectures, termination methods, bias resistors, and types of connecting
equipment.

Duplex Architectures

Duplex refers to the means of bandwidth usage in a serial system. The two
common means of bi-directional serial communication are full duplex and
half duplex. Half-duplex communication involves a transmitter and a
receiver connected to each end of the same wire or pair of wires. Because
the same transmission line is used for both sending and receiving data,
devices cannot send data in both directions at the same time. First, one
device transmits over the wire(s) to the receiver of the second device. When
the first device finishes transmitting, both devices switch the connections
from their transmitter to their receiver or vice versa. The device that was
receiving data can then transmit over the line.

In full-duplex communication, the devices use a separate wire (or pair of
wires) for simultaneous transmission in each direction. Thus, there is no
need to switch between transmitting and receiving.

In a differential serial bus (for example, RS-422 or RS-485), a half-duplex
system can transmit and receive over the same twisted pair of wires.
Thus, half-duplex communication is often referred to as two-wire
communications. Likewise, full-duplex communication is often referred
to as four-wire communications, because the full-duplex system uses a
separate pair of wires for communication in each direction.

Full Duplex

A typical full-duplex multidrop bus architecture involves a master-slave
protocol. Only one device, the master, can control access to the bus. All
other devices are slaves. Slave devices must wait for the master to give them
access to the bus. In a typical full-duplex system, one transmission line
connects the bus master’s transmitter to all of the slave receivers. A second
transmission line connects all of the slave transmitters to the bus master’s
receiver. Because in a differential system each transmission line is
composed of two separate wires, a full-duplex system is often referred to as
a four-wire system. Figure A-1 shows a typical full-duplex system.

© MNational Instruments Corporation A-3 PCMCIA Serial for Windows NT



Appendix A Serial Port Information

Slave 1 Slave 2 Slave n

Tx Tx Tx
Rx Rx Rx
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Figure A-1. Typical Full-Duplex System

Half Duplex

A typical half-duplex multidrop bus architecture also involves a
master-slave protocol. In a half-duplex system, all transmitters and
receivers are connected to the same transmission line. A half-duplex system
is often referred to as a two-wire system. Figure A-2 shows a typical
half-duplex system.

Slave 1 Slave 2 Slave n

WA WA YA

D

MASTER

&y
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Figure A-2. Typical Half-Duplex System
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Because each differential pair of wires is a transmission line, you must
properly terminate the line to prevent reflections. A common method of
terminating a two-wire multidrop RS-485 network is to install terminating
resistors at each end of the multidrop network. If you daisy-chained
multiple instruments together, you need a terminating resistor at only the
first and last instruments. The terminating resistor should match the
characteristic impedance of the transmission line (typically 100-120 ).
National Instruments offers an optional DB-9 RS-485 termination
connector that contains embedded terminating resistors for easy
termination.

Figure A-3 shows a multidrop network using terminating resistors.

Slave 1 Slave 2 Slave n

e e

1000 { 21000

MASTER

iy

DTE vs. DCE

Figure A-3. Multidrop Network Using Terminating Resistors

Data Terminal Equipment (DTE) and Data Communications Equipment
(DCE) were the terms used in the RS-232 specification for the types of
equipment on either end of a serial connection. (A DCE is called Data
Circuit-Terminating Equipment in Revision D of the RS-232 specification.)
In general, DTE and DCE refer to computer equipment and modems,
respectively. Because the RS-232 specification mainly involves connecting
a DTE directly to a DCE and vice versa, the pinouts are defined so that
cabling is simple. That is, a cable connected a computer to a modem by
wiring pin 1 to pin 1, pin 2 to pin 2, and so on. This method is commonly
known as straight-through cabling.
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Figure A-4 shows straight-through cabling in a DTE-to-DCE interface.
Pin 2|2 Ipin2 i Pin 2|l X2_Ipin2
DTE TxD DCE DCE TxD DTE
Pin 3| TxD g Ipin3 P Pin 3| TXD g Ipin3

PCMCIA Serial for Windows NT

Figure A-4. Straight-Through Cabling in a DTE-to-DCE Interface

Straight-through cabling is still the standard method to connect a modem to
your PC. However, because many applications use serial communication to
connect two or more DTEs without modems, the cabling becomes more
complicated. If two DTEs are wired together using a straight-through cable,
one transmitter is connected to the other transmitter, and one receiver is
connected to the other receiver. In this setup, no transmissions can occur.
Thus, these applications must use a cabling scheme that connects the
transmitter on one device to the receiver on the other device and vice versa.
This method is known as null-modem cabling, because it replaces the two
modems that traditional RS-232 applications would require between the
two DTEs. You should use a null-modem cable to communicate from one
serial port to another.

Figure A-5 shows null-modem cabling in a DTE-to-DTE interface.

Rx D Rx D

Pin 2 Pin 2

Tx D Tx D

Pin 3 Pin 3

Figure A-5. Null-Modem Cabling in a DTE-to-DTE Interface
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Uninstalling the Serial
Hardware and Software

This appendix explains how to uninstall your serial hardware and
NI-Serial software.

Removing the Hardware Information

Before physically removing the serial hardware, you must remove the
hardware information from the Windows NT Control Panel.
Follow these steps to uninstall the hardware:

1. Double-click on the niports icon under Start»Settings»Control
Panel.

2. Select the port to remove from the list of ports as shown in Figure B-1.

Mational Instruments - Ports

Parts:

Cloze

COME: M1 PCMCIA-232/2 &
COM?: M1 PCMCIA-232/2

Settings...

Delete. ..

i

Add & Mew PCMCIA card

PCMCIA-485 x| Add.

Figure B-1. Selecting an Interface to Uninstall

3. Click on the Delete button.

@ Note For two-port and four-port PCMCIA cards, all ports on the interface are removed.
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Uninstalling the NI-Serial Software

PCMCIA Serial for Windows NT

Before uninstalling the software, remove all serial port information from
the Windows NT Control Panel, as described in the previous section. You
do not need to shut down Windows NT before uninstalling the software.

Complete the following steps to remove the NI-Serial software:

1. Select Start»Settings»Control Panel.

2. Double-click on the Add/Remove Programs icon in the Control Panel
to launch the Add/Remove Programs applet. A dialog box similar to
the one in Figure B-2 appears. This dialog box lists the software
available for removal.

Add/Remove Programs Properties K E2
Install/Uninstall |\A-"indu:-ws Setupl Startup Diskl

% Toinstall a news program from a floppy disk or CO-BOM

drive, click Install.
Inztall...

The following software can be autoratically rermoved by
Windows, Toremove a program or ko modify itz installed
components, select it from the list and click
Add/Remave.

Microsoft Publisher 57 =]
Microzoft Small Business Financial Manager 97

Microsoft Wisual C++ 5.0

Microsoft Word 57
iN ahional [nehumer

NICAN v1.2.1 "
MI-CCDE for windows 95/MT
MIA154 for windows 35/MT
Nutega SaftiCE =l
Add/Remove. .. |
kK | Cancel | Spply |

Figure B-2. Add/Remove Programs Properties Dialog Box
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3. Select the serial software you want to remove, and click on the
Add/Remove button. The uninstall program runs and removes all
folders, utilities, and registry entries associated with the NI-Serial
software. Figure B-3 shows the results of a successful uninstallation.

Remove Programz From Your Computer E

unlnstallShield will remove the software '™ ational Instruments
Senial from pour computer. Please wait while each of the
following components iz remaved...

¥ Shared program files...
v Standard program files.
¥ Folder items...

¥ Program folders...

v Program directaries...

4

Program registry entries. ..

Uningtall successiully completed,

Figure B-3. Uninstallation Results

4.  Shut down Windows NT, power off your computer, and remove your
serial interfaces.

If you want to reinstall the hardware and software, refer to Chapter 2,
Installation and Verification.
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Troubleshooting and
Common Questions

This appendix describes how to troubleshoot problems and answers some
common questions.

Missing Serial Port in the niports List

The serial configuration utility niports contains configuration information
for serial hardware it is aware of that is installed in your system.

To start the configuration utility, select Start»Settings»Control Panel,
and double-click on the niports icon.

If serial ports are missing from this list, make sure you selected resources
for your PCMCIA card as described in the Select Resources for the
PCMCIA Card section in Chapter 2, Installation and Verification.

Resolving Resource Conflicts

Resource conflicts occur when your system contains hardware that is
configured to use the same resources as your serial interface. The serial
driver detects some resource conflicts when it loads. When the driver
detects conflicts as it loads, it records an error message describing the
conflict. You can use the Event Viewer to see which resource is in conflict.
To run the Event Viewer, select Start»Programs»Administrative
Tools»Event Viewer.

After you have identified the resource that caused the conflict, use the serial
configuration utility, niports, to reconfigure your serial interface so that it
uses conflict-free resources. For more information, refer to Chapter 3,
Configuration.
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To help in the selection of conflict-free resources, Microsoft has provided
a utility called Windows NT Diagnostics. This utility displays a list of the
I/O port addresses, IRQ levels, and DMA channels that are currently being
used in your system. Assign resources not listed by this utility to your serial
interface.

To run the Windows NT Diagnostics, select Start»Programs»
Administrative Tools»Windows NT Diagnostics.

Troubleshooting Diagnostic Messages

PCMCIA Serial for Windows NT

This section lists possible diagnostic error messages, along with solutions.

If the No National Instruments serial port found error
message appears, refer to Chapter 2, Installation and Verification,
to follow these troubleshooting steps:

1.

Verify the hardware resources. To verify the hardware resources,
click on the Resources button on the General Port Settings page.
For more information about resource conflicts, refer to Chapter 3,
Configuration.

Verify that the National Instruments serial driver is installed. Use
the Windows Explorer to display the Properties of serial.sys.

If either the serial hardware or serial. sys file is missing,
reinstall the hardware and software. You should find serial.sys
in the \WinNT\system32\drivers directory.

If the utility reports fewer ports installed than it should, refer to
Chapter 2, Installation and Verification, and follow these
troubleshooting steps:

1.
2.

Verify the hardware resources.

Verify that the National Instruments serial driver is installed. Use
the Windows Explorer to display the Properties of serial.sys.

Check the hardware installation to make sure the correct number
of boards/ports are installed.
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Appendix C Troubleshooting and Common Questions

e Ifthe I/0 address test failed, Interrupt test cannot
be performed error message appears, verify the hardware resources
as described in Chapter 3, Configuration. If the test still fails, you
probably have an I/O address conflict with other boards in your
system. Use the niports configuration utility to change the base 1/0
addresses assigned to your ports. For more information, refer to
Chapter 3, Configuration.

* Ifthe Interrupt test failed error message appears, verify the
hardware resources as described in Chapter 3, Configuration. If the
test still fails, you probably have an IRQ conflict with the boards in
your system. Use the niports configuration utility to change the IRQ
level assigned to your port. For more information, refer to Chapter 3,
Configuration.

Common Questions

How can I determine which type of serial hardware I have installed?

Double-click on the niports icon under Start»Settings»Control Panel to
display a list of installed ports.

What do I do if the diagnostic test fails with an error?

Refer to the troubleshooting sections of this manual for specific
information about what might cause the test to fail.

How can I determine which port is associated with COMx?

Refer to the section Determine Which Physical Port Is Associated with
COMcx, in Chapter 2, Installation and Verification.

How can I change the COM numbers of my National Instruments
serial ports?

Refer to the General Port Settings section in Chapter 3, Configuration.
How can I determine which version of the NI-Serial software I have
installed?

The Read Me file lists the version of the software. To read the file, select
Read Me under Start»Programs»National Instruments Serial.
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Specifications

This appendix describes the characteristics of the serial hardware, the
NI-Serial software, and the recommended operating conditions.

Hardware Specifications

Table D-1. Physical Characteristics of the PCMCIA Serial Cards

Characteristic Specification
Dimensions 85.6 by 54.0 by 0.5 cm
(3.370 by 2.126 by 0.197 in.)
I/0 Connector Special Cable with DB-9 Dsub
Connector and Converter for
PC Card

Power Requirement
(from PCMCIA expansion slot)

PCMCIA-232 +5 VDC 40 mA Typical
PCMCIA-485 +5 VDC 100 mA Typical
PCMCIA-232/2 +5 VDC 60 mA Typical
PCMCIA-485/2 +5 VDC 100 mA Typical
PCMCIA-232/4 +5 VDC 60 mA Typical
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Appendix D Specifications

Table D-2. Environmental Characteristics of the Serial Hardware

Characteristic

Specification

Operating Environment

Component Temperature
Relative Humidity

0to70°C
10 to 90%, noncondensing

Storage Environment

Temperature
Relative Humidity

—40to 120° C
5 to 90%, noncondensing

EMI

FCC Class A Verified

Software Specifications

PCMCIA Serial for Windows NT

Table D-3. Software Characteristics

Characteristic

Specification

Maximum Serial Transfer Rate

115,200 bps*

* Actual speed may vary considerably from speed shown due to system and

instrumentation capabilities.
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Technical Support Resources

Web Support

National Instruments Web support is your first stop for help in solving
installation, configuration, and application problems and questions. Online
problem-solving and diagnostic resources include frequently asked
questions, knowledge bases, product-specific troubleshooting wizards,
manuals, drivers, software updates, and more. Web support is available
through the Technical Support section of ni . com

NI Developer Zone

The NI Developer Zone at ni . com/zone is the essential resource for
building measurement and automation systems. At the NI Developer Zone,
you can easily access the latest example programs, system configurators,
tutorials, technical news, as well as a community of developers ready to
share their own techniques.

Customer Education

National Instruments provides a number of alternatives to satisfy your
training needs, from self-paced tutorials, videos, and interactive CDs to
instructor-led hands-on courses at locations around the world. Visit the
Customer Education section of ni . com for online course schedules,
syllabi, training centers, and class registration.

System Integration

If you have time constraints, limited in-house technical resources, or other
dilemmas, you may prefer to employ consulting or system integration
services. You can rely on the expertise available through our worldwide
network of Alliance Program members. To find out more about our
Alliance system integration solutions, visit the System Integration section
of ni.com

© National Instruments Corporation E-1 PCMCIA Serial for Windows NT



Appendix E Technical Support Resources

Worldwide Support

National Instruments has offices located around the world to help address
your support needs. You can access our branch office Web sites from the
Worldwide Offices section of ni . com. Branch office Web sites provide
up-to-date contact information, support phone numbers, e-mail addresses,
and current events.

If you have searched the technical support resources on our Web site and
still cannot find the answers you need, contact your local office or National
Instruments corporate. Phone numbers for our worldwide offices are listed
at the front of this manual.
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Glossary

Prefix Meaning Value
p- pico- 10-12
n- nano- 109
y- micro- 10-¢
m- milli- 10-3
k- kilo- 103
M- mega- 106
G- giga- 10°
t- tera- 1012
° degrees
% percent
Q ohms
A amperes
ANSI American National Standards Institute
b bits
B bytes
baud bits per second
bps bits per second
C Celsius
COM Computer Output Microform
CTS Clear To Send
DB-xx subminiature D connector (where xx is the number of pins)
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Glossary

DCD
DCE
DMA
DSR
DTE

DTR

EIA
EMI
FCC
FIFO
ft.
GND
HSI

HSO

IEEE
in.
/0
IRQ
ISA

Kbaud

PCMCIA Serial for Windows NT

Data Carrier Detect

Data Communications Equipment or Data Circuit-Terminating Equipment
direct memory access

Data Set Ready

Data Terminal Equipment

Data Terminal Ready (where the overscore denotes that the signal
is active low)

Electronic Industries Association
electromagnetic interference

Federal Communications Commission
first-in-first-out

feet

Ground

Handshake Input

Handshake Output

hertz

Institute of Electrical and electronic Engineers
inches

input/output

interrupt request

Industry Standard Architecture
kilobits per second

meters
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MB

PC

PCI

PCMCIA

PnP

RAM

RI

RX

RXD

RTS

SCSI

TX

TXD

TXRDY

UART

VDC

VXI

Glossary

megabytes of memory

personal computer

Peripheral Components Interconnect

Personal Computer Memory Card International Association
Plug and Play

random-access memory

Ring Indicator

Receive

Receive Data

Request to Send

seconds

Small Computer Systems Interface

Transmit

Transmit Data

Transmit Ready (where the overscore denotes that the signal is active low)
universal asynchronous receiver/transmitter

volts

volts direct current

VME eXtensions for Instrumentation
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Index

A

add/remove programs properties dialog box
(figure), 2-2, B-2
advanced transceiver control for the
PCMCIA-485, 4-1
four-wire mode, 4-1
setting transceiver control mode, 4-2
transceiver mode control modes (table), 4-1
two-wire mode: DTR controlled, 4-2
two-wire mode: DTR with Echo, 4-2
two-wire mode: TXRDY auto control, 4-2

C

cable connection, 2-6
changing communication port settings, 3-1
COM port number, 3-3
common questions, C-3
determining port associated with
COMyx, C-3
determining type of serial hardware
installed, C-3
determining version of NI-Serial software
installed, C-3
diagnostic test failure, C-3
naming National Instruments serial
ports, C-3
communication port settings, 3-1
viewing or changing, 3-1
communication port settings configuration, 3-1
configuration, 3-1
connecting cables, 2-6
connecting two-wire devices, 2-7
conventions, xi
customer education, E-1
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D
DB-9
pin descriptions (table), 2-6
pin locations (figure), 2-6
DCE vs. DTE, A-5
determining port associated with COMx,
2-5,C-3
determining type of serial hardware
installed, C-3
determining version of NI-Serial software
installed, C-3
development tools for saving time, 1-3
DeviceloControl, 4-3
input values (table), 4-3
setting transceiver mode with, 4-3
diagnostic messages, C-2
troubleshooting, C-2
diagnostic test failure, C-3
DTE vs. DCE, A-5
DTE-to-DCE interface, A-6
straight-through cabling in (figure), A-6
DTE-to-DTE interface, A-6
null-modem cabling in (figure), A-6
duplex architectures, A-3
full duplex, A-3
half duplex, A-4

E

environmental characteristics of serial hardware
(table), D-2

F

FIFO buffer size, 3-3
FIFO enabled, 3-3
FIFO buffer size, 3-3
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Index

four-wire mode, 4-1
full duplex, A-3
full-duplex system (figure), A-4

G

general port settings, 3-2
COM port number, 3-3
dialog box (figure), 3-2
FIFO enabled, 3-3
resources, 3-3
transceiver mode, 3-3
general programming requirements, 4-4
getting started, 1-2
glossary, G-1

H

half duplex, A-4

half-duplex system (figure), A-4
hardware installation, 2-3

getting started, 1-2

verification, 2-5
hardware specifications, D-1

installation
determining port associated with
COMy, 2-5
getting started, 1-2
PCMCIA serial card installation
(figure), 2-4
running the diagnostic test, 2-5
selecting resources for the PCMCIA
card, 2-4
serial hardware, 2-3
serial software, 2-1
verification, 2-1
verifying hardware installation, 2-5
introduction, 1-1

PCMCIA Serial for Windows NT -2

L

LabVIEW, 1-3

using with serial hardware, 1-4
LabWindows/CVI, 1-3

using with serial hardware, 1-4

missing serial port in the niports list, C-1
multidrop network using terminating resistors
(figure), A-5

naming National Instruments serial ports, C-3

National Instruments Web support, E-1

NI Developer Zone, E-1

NI serial setup screen (figure), 2-3

niports configuration utility (figure), 3-1

null-modem cabling in a DTE-to-DTE
interface (figure), A-6

0

optional equipment, 1-2
overview of serial hardware, 1-2
overview of serial software, 1-3

P

PCMCIA card installation (figure), 2-4
PCMCIA serial card physical characteristics
(table), D-1
PCMCIA-485, 2-7
advanced transceiver control for, 4-1
setting transceiver control mode, 4-2
transceiver mode control modes
(table), 4-1

two-wire mode: DTR controlled, 4-2
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two-wire mode: DTR with Echo, 4-2
two-wire mode: TXRDY auto
control, 4-2
pin descriptions
DB-9
connector pin descriptions
(table), 2-6
connector pin locations
(figure), 2-6

R

related documentation, xii
resolving resource conflicts, C-1
resource configuration dialog box for the
PCMCIA-485 (figure), 3-4
resource configuration dialog box for the
PCMCIA-485/2 (figure), 3-5
resource settings, 3-4
PCMCIA-232, PCMCIA-485,
PCMCIA-232/4, 3-4
PCMCIA-232/2, PCMCIA-485/2, 3-5
RS-232 standard, A-1
features (table), A-1
RS-422 standard, A-2
features (table), A-1
RS-485 standard, A-2
features (table), A-1
running the diagnostic test, 2-5

S

selecting an interface to uninstall (figure), B-1
selecting resources for the PCMCIA card, 2-4
serial communication issues, A-3
DTE vs. DCE, A-5
duplex architectures, A-3
serial hardware
general programming requirements, 4-4
installation, 2-3
overview, 1-2
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selecting an interface to uninstall
(figure), B-1
uninstalling, B-1
using, 4-1
using with LabVIEW and
LabWindows/CVI, 1-4
serial hardware environmental characteristics
(table), D-2
serial port information, A-1
serial software
add/remove programs properties dialog
box (figure), B-2
installation, 2-1
overview, 1-3
successful uninstallation (figure), B-3
uninstalling, B-2
setting transceiver control mode, 4-2
setting with DeviceloControl, 4-3
setup screen for NI serial software (figure), 2-3
software characteristics (table), D-2
software installation, 2-1
getting started, 1-2
software specifications, D-2
specifications, D-1
hardware specifications, D-1
serial hardware environmental
characteristics (table), D-2
PCMCIA serial card physical
characteristics (table), D-1
software characteristics (table), D-2
software specifications, D-2
straight-through cabling in a DTE-to-DCE
interface (figure), A-6
successful uninstallation (figure), B-3
system integration, by National
Instruments, E-1
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T

technical support resources, E-1
termination, A-5

multidrop network using terminating

resistors (figure), A-5

time-saving development tools, 1-3
transceiver control modes (table), 4-1
transceiver mode, 3-3

setting with DeviceloControl, 4-3
troubleshooting, C-1

diagnostic messages, C-2

missing serial port in the niports list, C-1

resolving resource conflicts, C-1
two-wire devices, 2-7

connecting, 2-7
typical full-duplex system (figure), A-4
typical half-duplex system (figure), A-4
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uninstalling serial hardware, B-1
uninstalling serial software, B-2
using serial hardware, 4-1

using this manual, 1-1

V

verifying hardware installation, 2-5
viewing or changing communication port
settings, 3-1

W

Web support from National Instruments, E-1
worldwide technical support, E-2
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